
Procedure for Completing the HCBS Waiver Plan of Treatment 

The Home and Community-Based Services (HCBS) Waiver Plan of Treatment (POT) is a 
Word-based document that can be filled out either electronically or manually.  Please contact 
the In-Home Operations (IHO) Section to receive a copy of the electronic version of this 
document   We can either e-mail you a copy, or if you mail us a blank 3¼-inch floppy disk or 
CD with a self-addressed envelope we will mail you a copy.  IHO has included a manual 
version of the POT in this packet.  (See Enclosure 4A - HCBS Manual POT.)  

This POT can be used for Medi-Cal beneficiaries receiving services through one of the HCBS 
Waivers administered by IHO and/or Private Duty Nursing (PDN) services through the Medi-
Cal Early and Periodic Screening, Diagnosis, and Treatment (EPSDT) Benefit.  Below are 
general directions for completing each section of the form. 

The Comments section may be used throughout the document to provide explanatory 
information as necessary.   

The completed POT must contain original signatures from: 
• the beneficiary and/or the legal representative,  
• primary care physician, and 
• for HCBS Waiver beneficiaries, each HCBS Waiver service provider; i.e., primary 

caregiver, home health agency (HHA), or Independent Provider (IP), or 
• for EPSDT beneficiaries, each IP.   

Once all signatures have been obtained, keep the original and return a signed copy of the 
POT to the appropriate IHO Regional Office. 

Step 1:  (For the Electronic POT only) 
(Note:  For the manual version go to Step 1A)

1. Unlock the document; 
2. Go to the View menu; 
3. Click on Toolbars; 
4. Click on Forms; 

(A √ should appear next to Forms.  The Forms toolbar will appear with the LOCK button 
turned on.  In the “Locked” mode the button wilI have a light gray background.) 

5. Click on the LOCK button.  In the “Unlocked” mode the button will have a medium gray 
background; and, 

6. Complete the header (see below to access header) at the top of Page 2 by entering the 
beneficiary’s name and the treatment period “from and to” dates; 

7. Relock the document prior to entering data in the form fields; 
8. Complete the POT as instructed in Step 3 below.  
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Procedure for Completing the HCBS Waiver Plan of Treatment, cont.  

How to access the header (2 methods): 

Method A:  Go to Page 2.  Using your mouse, double-click on the header and enter the 
information.  To exit this function using your mouse, double-click on any area outside of the 
header.  This information will then auto-fill on the subsequent pages. 

or

Method B:  Go to the View menu, click on Header and Footer and scroll down to Page 2.  
Enter the information in the Header.  To exit this function, go back to the menu bar, click on 
View, and click on the √ next to Header and Footer. 

Helpful hints for using the electronic version

1. Important:  Use the Tab key to navigate the fields.  Do not use the ENTER/RETURN key, 
as it will alter the formatting and disrupt the spacing throughout the document. 

2. This document has been developed with check boxes, drop-down menus, and locked 
fields. 
• Check boxes can be marked with an X by placing the cursor over the box and using 

the mouse to single-click on it. 
• Drop-down menus (Section 7, Waiver Specific Services) can be accessed by: 

* placing the cursor over the box; 
* single-clicking it with the mouse; and, 
* selecting the appropriate response.   

•     Locked fields appear as gray-shaded areas and are preset so the user can tab 
through the document from one to the next.  You can also use your mouse to 
maneuver around the document. 

3. Be sure that the Lock button is turned ON prior to entering information.  If the Lock button 
is turned off prior to completion, the form will not work properly. 

To lock the document, click on the LOCK button.  The button background will change to 
light gray. 

IMPORTANT:  If the Lock button is turned back ON after any information has been  
entered on the POT, it will delete all of the information you have entered on the POT. 

4. In order to spell check the document, the POT must be entirely completed and the Lock
button must be turned Off.  Go to the Tools drop-down menu and click on Spelling and 
Grammar.  Once the spell check is complete, you can save the document by going to the 
File drop-down menu, click Save As. Remember, if you then relock the document, all 
entries will be lost! 
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Procedure for Completing the HCBS Waiver Plan of Treatment, cont.  

Step 1A:  (For the Manual POT only) 

On Pages 2 through 13, complete the header by entering the beneficiary’s name and the 
treatment period “from and to” dates, then complete the POT as instructed in Step 2. 

Step 2:  Completing the HCBS POT (For both the Electronic and Manual POT) 

Collaborate with the beneficiary, their representative, and the physician in the development of 
the POT to ensure the beneficiary’s medical needs are addressed. 

Section 1:   Beneficiary Information 

Please complete as indicated.  The medical record number of the beneficiary is optional 
and is used for the provider’s filing purposes.  The primary language may include the 
primary caregiver’s primary language, if different from that of the beneficiary. 

Section 2:  HCBS Provider Information 

Please complete as indicated.  The provider name is the name of the agency, individual or 
organization who is primarily responsible for the services described on the POT.  This would 
include the Home Health Agency, HCBS Waiver Service Provider, Professional Corporation 
(PC), Personal Care Agency (PCA), Nonprofit Organization or the lead Provider (for 
beneficiaries receiving services without Case Management).  The treatment period may 
vary depending upon licensure and/or certification requirements of the provider. 

Section 3:  Primary Care Physician 

Please complete as indicated.  The community-based Primary Care Physician should be
the physician signing the POT. 

Section 4:  Medical Information 

Please complete as indicated.  Include all ICD-9 codes or diagnosis codes where 
appropriate.  The other diagnosis section may be used if there are other diagnoses 
pertaining to the beneficiary.  You may contact the Primary Care Physician to obtain the 
diagnosis and ICD-9 codes.  For the prognosis, please check only one of the boxes 
provided for you, i.e., excellent, good, fair, or poor. 

Section 5:  Medi-Cal Home- and Community-Based Program 

Please check all of the appropriate programs for which services are being requested.  Please 
contact your IHO Case Manager to obtain the appropriate program information. 
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Procedure for Completing the HCBS Waiver Plan of Treatment, cont.  

Section 6:  Level of Care (LOC) 

The level of care determination will be made by the Medi-Cal In-Home Operations 
Section and given to the provider.  Please contact your IHO Case Manager for the level of 
care.  Check only one box once a determination has been provided. 

Section 7:  Waiver Specific Services 

Do not complete this section for beneficiaries receiving only EPSDT PDN services.

Please complete as indicated.  All the Waiver Specific Services are listed in this section.  
Please check all of the services the beneficiary is utilizing.  If using the document 
electronically, please click on the arrow under the Frequency Key Code, and double-click on 
the appropriate Key Code.  If other is used, please provide frequency. 

Section 8: Treatment Plan for Home Program 

Identify all of the services required to meet the needs of the beneficiary in this section. M.D. 
orders must identify all waiver services rendered by all providers.  Please list/describe all 
waiver services provided, including the: 
• provider(s) of service; 
• provider type(s); 
• amount and frequency of the services;  
• type of services provided; and, 
• expected outcomes 

Identify the beneficiary’s support network, i.e.;, who will provide care to the beneficiary in the 
absence of the scheduled caregivers.  

Section 8a:  Treatment Plan for Home Program – Additional page if needed 

Section 9:  Non-Waiver Services 

For beneficiaries enrolled in one of the HCBS Waivers, federal regulations require that all 
non-waiver services the beneficiary is receiving be described in the POT.  The description of 
the services should include the amount, frequency, and the provider of services.  Non-waiver 
services may include services funded by:   

• Medi-Cal • Department of Mental Health • California Children’s Service 
• Private Insurance • In-Home Supportive Services • Department of Rehabilitation 
• Regional Centers • Independent Living Centers • Social Services Referrals 
• Respite  • Housing referrals • Medical Therapy Program 

This may also include school-based services, such as:  
• Adult Day Health Care • Pediatric Day Health Care 
• Vocational Rehabilitation • Medical Therapy program 
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Procedure for Completing the HCBS Waiver Plan of Treatment, cont.  

Section 10:  Medication Plan for Home Program 

Please complete as indicated.  This includes prescription and nonprescription medications.  
Space for additional medications has been provided for you on Page 5 of the POT. 

Section 10a:  Medication Plan for Home Program – Additional page if needed 

Section 11:   Nutritional Requirements 

Please describe any nutritional requirements for the beneficiary, as ordered by the physician.  
Please indicate the type of diet, method of feeding, amount, and frequency.

M.D. orders must identify all services rendered by all providers.  Please list/describe all 
services provided, including the: 
• provider(s) of service; 
• provider type(s); 
• amount and frequency of the services; and, 
• type of services provided. 

Space for additional orders has been provided for you on Page 7 of the POT. 

Section 12:  Functional Limitations

Please describe functional limitations, per the physician’s order, within each category. 
If no limitations are noted, please check the appropriate boxes and proceed to Section 13. 

A. MOTOR may include but is not limited to:  
• ambulation • wheelchair 
• amputation • crutches 
• paralysis • cane 
• contracture • walker 
• partial weight bearing 

B. SELF-HELP may include but is not limited to:  
• independent • incontinent of bowel or bladder 
• requires feeding • requires verbal cueing for tasks 
• personal hygiene assist • requires moderate assist with dressing 

C. COMMUNICATION/SENSORY  i.e., hearing, speech, legal blindness, or glasses 
• hearing • vision 
• speech • pain 
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Procedure for Completing the HCBS Waiver Plan of Treatment, cont.  

Section 13:   Activities 

Describe all activities performed by the beneficiary, as per the physician’s order, such as:   
• up as tolerated • complete bed rest 
• endurance • bed rest with BRP 
• dyspnea with exertion • exercises as prescribed 

If no restrictions on activities are noted, please check the appropriate box and proceed to 
Section 14. 

Section 14:   Mental Status  

Summarize the mental status of the beneficiary, such as:
• comatose • poor short-term memory 
• depressed • disoriented to date, time and place, oriented to person 
• lethargic • agitated
• easily confused • developmentally delayed with moderate retardation 

If no limitations are noted, please check the appropriate box and proceed to Section 15. 

Section 15: Durable Medical Equipment  

Please list all types of equipment used, providers of equipment, and funding sources (if 
known), such as Medi-Cal, Medicare, private insurance, or private pay.  Example:  

Type
Zippy wheelchair, serial # XXXXXX

 Provider Name
 Acme Healthcare 

 Funding Source
Medicare 
Medi-Cal 
Red Cross Insurance 

Alternating pressure mattress overlay Acme Healthcare 
LTV 800 ventilator 

Section 16: Medical Supplies  

Acme Respiratory 

Please list all types of supplies used, providers of supplies, and funding sources (if known), 
such as Medi-Cal, Medicare, private insurance, or private pay.  Example:  

Type
G-tube feeding supplies 
Huggies diapers 

 Provider Name
Acme Healthcare 
Acme Healthcare 

 Funding Source
Medi-Cal 
Private pay 

Section 17: Therapies/Referrals  

Please check all types of therapy that apply.  Provide the date of each referral and the 
reason(s) why the referral was made.  If therapy is ongoing, please indicate the current 
progress/status in Section 20.  If the type of therapy is not listed, please use the other/list.  
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Procedure for Completing the HCBS Waiver Plan of Treatment, cont.  

Section 18: Treatment Goals/Discharge Plans  

Please check the appropriate box.  If you select anything other than “Upon completion of 
treatment plan, the beneficiary will be able to function independently…” you must check the 
level of support needed (minimal, moderate, or maximum), and describe specific goals and 
discharge plans as identified on the POT such as:  

• beneficiary will be able to self-direct caregivers in trach care,  
• primary caregivers will be knowledgeable in diabetic management,  
• caregivers will be knowledgeable in pressure relief. 

Section 19: Training Needs for Beneficiary/Family  

Please check only one box for training needs.  If you choose yes, use the area  
provided to describe the training needs of the beneficiary/family and list the name(s) of the 
provider(s).  Beneficiary/family training must be preauthorized by your IHO Case Manager.   

Section 20: Summary of Beneficiary’s Status During This Treatment Period 

Please summarize the status of the beneficiary during the treatment period for this POT.  
This area may also be used, as stated in Section 17, to describe the current progress/status 
of ongoing therapy.  Each INP is to provide a summary of the care he/she provided, the 
overall status of the beneficiary, and include the beneficiary’s response to the POT and any 
significant changes.

Section 21:  Signatures page   

Please complete the POT Form, then print, and obtain original signatures from the 
following: 

• Primary Care Physician who oversees the beneficiary’s home program; 
• Beneficiary and/or the legal representative; 
• Primary Caregiver (i.e., parent, spouse, or family member); 
• All providers of HCBS Waiver services (this includes HHA, Waiver Personal Care 

Services Providers, Independent Providers, Professional Corporation, and the Case 
Manager); and,  

• For beneficiaries receiving only Medi-Cal EPSDT INP services, all INPs.
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Procedure for Completing the HCBS Waiver Plan of Treatment, cont.  

Upon completion of the POT, keep the original, place a copy in the beneficiary’s home chart, 
and mail a copy with the Treatment Authorization Request (TAR) and any other required 
documents to the attention of the beneficiary’s IHO Case Manager at the address selected 
below: 

Department of Health Care Services 
In-Home Operations Section 
1501 Capitol Avenue, MS 4502 

 P.O. Box 997437 
Sacramento, CA 95899-7437  

   
   

 Los Angeles, CA 90013-1211 

Department of Health Care Services 
In-Home Operations Section 
311 South Spring Street, Suite 313 
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